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This Tutorial 

Tutorial Objective 
This tutorial interactively introduces how to make use of the Insert Viewshed command within 
GeoMedia 3D.  The intent of this tutorial is not to review all aspects of the Insert Viewshed 
command, but to provide you with a collection of workflows to help you get started. In this tutorial, 
you will learn about defining, inserting, and editing viewshed features in a GeoMedia 3D map 
window.  

 

Tutorial Data Set 
The exercises outlined in the GeoMedia 3D tutorials make use of specific data sets.  Specifically, 
the GeoMedia 3D tutorial data sets include: vector sources (point, line, and area features) and a 
small collection of 3D building models in 3DML format. 

 

Tutorial Text Conventions 
There are several conventions used throughout the tutorial: 

 Ribbon bar items are shown as: On the Aaa tab, in the Bbb group, click Ccc. 

 Dialog box names, field names, and button names are depicted using Bolded Text. 

 Information to be entered, either by selecting from a list or by typing, is depicted using 
italicized text. 

 

Tutorial Prerequisites 
There are no prerequisites for making use of this tutorial; however, having a basic understanding 
of the GeoMedia Desktop will be helpful in executing certain steps within this tutorial.   





 

   

Understanding and Section 1:  
Leveraging Viewsheds 

Section Objective 

This section is intended to introduce you to the fundamental workflows associated with creating 
and managing viewshed features. Namely, in this section you will learn about: 
 

 Creating viewshed feature classes. 

 Inserting viewshed features. 

 Editing and stylizing viewshed features. 

 Making use of an existing point feature class to create a collection of viewshed features. 

 

3D Viewshed Analysis 

In GeoMedia 3D, viewshed features are represented by 3D polygons. These 3D polygons depict 
the visible areas from a specific location. Similar to other viewshed technologies, the Insert 
Viewshed command in GeoMedia 3D uses a number of inputs such as horizontal/vertical fields 
of view, pitch angle, viewing distance, and viewer height to guide the line-of-sight/ray tracing 
process. However, the Insert Viewshed command in GeoMedia 3D, unlike other viewshed 
approaches, takes 3D objects such as building models, feature models, and point clouds into 
consideration when calculating the visible areas. Given this, the Insert Viewshed command can 
produce viewshed features that accurately reflect the real world.  

 
Application Areas 

Viewshed analysis has a wide variety of applications in security, government, infrastructure, 
resource development, and tourism. One particular area where viewshed analysis has been used 
extensively is in determining where to locate communication towers.  Another way viewshed 
analysis can be used is to estimate the impact of the addition of a large building into an existing 
cityscape. This viewshed analysis would show all the areas from which the building could be seen 
as well as any views that would be obscured.  
 

Tools Used 

This section makes use of the Insert Viewshed and Style Properties commands. 
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 Creating a Viewshed Feature Exercise 1:

Objective: 
You must have a Viewshed feature class in place before you can make use of the Insert 
Viewshed command. The objective of this exercise is to create a viewshed feature class. 

Task 1: Launch GeoMedia 

A GeoMedia GeoWorkspace has been created for this exercise.  

1. Use your mouse and desktop controls to navigate to C:\GeoMedia 3D 2015_1 
Tutorials\Viewsheds. 

2. Double-click Exercise.gws.  This action will start GeoMedia Desktop and open the 
GeoWorkspace called Exercise. 

 

This GeoWorkspace has 3 legend entries (Viewer_Locations, Building_Mesh, and 
StreetCasings). 

 The Viewer_Locations feature class contains 3 locations.  These will be used later in 
this tutorial to illustrate how an existing point-based feature class can be used to create 
viewshed features.  

 The Building_Mesh feature was created using the Contruct 3D Mesh Layer command 
and then added to the GeoWorkspace using the Insert 3D Mesh Layer. This layer has 
been stylized to display 3D building models when in 3D. These features will be used to 
demonstrate how 3D models affect the placement and results of viewshed analysis.  

 The StreetCasings feature class simply provides some additional context to the map.  

Task 2: Navigate to a place of interest 

The process of inserting a viewshed is dynamic; specifically you use the mouse to interactively 
define viewshed parameters. Given this, it is best to navigate your view to a position that allows 
you to accurately place a viewshed eye point and define viewing parameters such as the distance 
from the viewshed eye point.  
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Please note however, that even after placement of a viewshed, the location of the eye point can 
modified using standard GeoMedia editing techniques, and the viewing parameters can be 
modified using the attributes found within the viewshed feature class. We will learn more about 
this later. 

1. Click the maximize button in MapWindow1 to maximize the map window. 

2. Use the navigation tools to navigate to an area that is similar to the one in the 
example provided below. 

 

Task 3: Create a Viewshed Feature Class 

You must have one or more read-write viewshed feature classes available for use with the Insert 
Viewshed command as these are used to store location information and viewshed parameters.  

You can create these features classes manually; however, it is simpler to create one using the 
Create Viewshed Feature Class dialog box. 

1. On the 3D tab, in the Analysis group, click Viewshed to display the Insert 
Viewshed dockable control. 

  

2. Click  to display the Create Viewshed Feature Class dialog box. 

 

The Create Viewshed Feature Class dialog box is used to add a 
new viewshed feature class to a read-write warehouse connection in 
the active GeoWorkspace.  

When you create a new viewshed feature class, it will automatically 
become the selected feature class in the Insert Viewshed dockable 
control drop-down list. 

3. Use the Warehouse drop-down list to select Base Map as the output warehouse. 

4. Use the Feature class name text box to specify Viewshed as the output feature 
class name. 

file:///C:/Temp/F_699179
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5. Click the OK button to create the specified feature class named Viewshed in the 
warehouse connection called Base Map. 

 

Notice the drop-down list in the Insert Viewshed dockable control is 
automatically populated with the new feature class name and all of 
the viewing parameters are populated with default values. 

Task 4: Insert a Viewshed 

There are a large number of ways to interact with the Insert Viewshed dockable control. In this 
task, we will make use of all the default settings. 

When the Insert Viewshed command is active, prompts are displayed in the status bar at the 
lower-left corner of the GeoMedia application workspace to assist you with the placement 
procedure. 

 

Notice the prompt Click to define viewshed eye point that is 
displayed in the status bar at the lower-left corner of the GeoMedia 
application. 

1. Use your mouse to move the cursor to a location similar to where the yellow symbol 
is in the example below.  
 
Ensure that your cursor is very close to the edge of the rooftop or even on the side of 
the building. This will ensure that the viewshed is unobstructed by the rooftop and 
hence will be able to see other buildings. 

 

2. Click the left mouse button to define the viewshed eye point and then slowly move 
your cursor to the right portion of the screen. 

 

Notice the prompt Click to complete viewshed definition that is 
displayed in the status bar at the lower-left corner of the GeoMedia 
application. 
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If you do not like the location you have specified for the viewshed eye 
point, click the right mouse button to restart the viewshed eye point 
definition process. 

 

 

 

As you move your cursor, the viewshed is dynamically displayed in 
the context of the 3D window and the fields within the Insert 
Viewshed dockable controls update to reflect the mouse 
movements. 

3. Once you have a viewshed that looks similar to the one in the example above, click 
the left mouse button to complete the viewshed definition process. 

4. Soon after the second click, the Viewshed Properties dialog will be displayed.  

5. Click the Attributes tab to bring this tab to the forefront. 

 

6. The Attributes tab displays a collection of attributes for the created viewshed. These 
reflect the parameters used to create the initial viewshed. You can accept these 
values or you can modify them.  
 
Before closing the Viewshed Properties dialog, let us review the attributes to gain a 
better understanding of each. 
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Parameter Description 

ID Identifies each viewshed record in the feature class.  

Name Contains a name for each viewshed in the feature class.  
Note: The default viewshed name for each record will be the word 
“Viewshed” and the record ID value appended.  However, it is 
allowable for the user to change this name. When changing the 
name, it is not required that the new name be unique.  

Pitch 

 

 

Contains a value expressed in degrees (-90 to 90). This value 
controls the pitch angle for the viewshed.  

Using 0 degrees creates a horizontal ray from the viewshed eye 
point to the center of the outermost edge of the viewshed plane.  
Using -90 will create a vertical ray looking downwards and using 
90 degrees creates a vertical ray looking upwards. 

Direction 

 

 

Contains a value expressed in degrees (0 to 360). This value 
controls the view direction for the viewshed. A value of 0 reflects 
the northern apex of a virtual compass. A value of 90 creates a 
view direction from the viewshed eye point along an easterly path. 

Distance 

 

 

Contains a value that is expressed in the distance units of 
measure of the GeoWorkspace.  

This value controls the distance from the viewshed eye point to the 
outermost edge of the viewshed plane. 

IsSpherical 

 

 

Contains a boolean value of either True or False, where True 
toggles the viewshed to a sphere.  

Horizontal_FOV 

 

 

 

Contains a value expressed in degrees (1 to 120).  

This value controls the horizontal field of view for the viewshed. 

Vertical_FOV 

 

 

 

Contains a value expressed in degrees (1 to 180).  

This value controls the vertical field of view for the viewshed. 

 

7. Now that we have a better understanding of these attributes, click OK in the 
Viewshed Properties dialog to close the dialog box. 

8. Click the Esc key on your keyboard to exit the Insert Viewshed command. 
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 Understanding and Leveraging Exercise 2:
the Viewshed Style Definitions 

Objective: 
Stylization is used to control how viewshed features appear within both a 2D map window and the 
3D map window. The objective of this exercise is to gain a basic understanding of these style 
definitions and how they can be used to display viewshed features.  

Task 1: Understand Viewshed Features 

When a viewshed feature is created using the workflow noted above, the newly created viewshed 
is automatically placed into the active map window legend using a specific set of stylization 
parameters. Understanding these parameters will be helpful should you want to recreate similar 
viewshed features in another GeoWorkspace. 

1. On the 3D tab, in the View group, click Toggle 3D to toggle the current 3D map 
window to a 2D map window. 

Viewshed features, like all 3D features in GeoMedia, are stored as 2.5D features. Since viewshed 
features consist of a point and an area, these entities are stored in the feature database using a 
compound feature type.  

 

Compound features are commonly used to store features that consist of two or more geometry 
types (e.g. Point, Line, or Area). When these types of features are displayed, the legend entry 
containing these will have an icon that looks similar to this: .  

These features, like all features within GeoMedia, can be stylized and you can even modify the 
individual components of each geometry type. In the example below, the Point Symbol, Area 
Fill, and Area Boundary have been modified to illustrate some of the components that make up 
a viewshed compound geometry. 

 

 

Task 2: Modify Symbol Style 

As noted in previous tutorials, styles are used to affect how features appear in a 2D map window 
and the 3D map window. Most styles translate successfully from 2D to 3D but there are a few 
which do not and therefore some are ignored when in 3D. For now, we are going to make a 
number of changes to the viewshed feature style and explore which styles apply when and how. 
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1. Double click the  icon of the legend entry Viewshed to display the Legend Entry 
Properties dialog box. 

2. Click the Properties button to display the Style Properties dialog. 

3. Click the Symbol Style entry under the Point Styles in the tree view to select this 
entry. 

 

4. Choose Star Filled from the Name drop-down control. 

5. Choose 72 (pt) from the Size drop-down control. 

6. Specify a black color (use the icon to the right of the Define override color). 

7. Click the 3D Settings tab to bring this tab to the forefront. 

 

Notice that Use relative altitude based on is set to Ellipsoid and 
that Use geometry Z values for altitude is checked. 
 
These settings are important and should remain as is because these 
options affect where the point symbol used to define the location of 
viewshed eye point appears when in 3D. 
 
If you were, for example, to change the Altitude options to Drape 
on surface, your viewshed will still look correct, but your point 
symbol representing the viewshed eye point would be placed on the 
surface. 

8. Place a checkmark beside Replace with 3D object. 

9. Use the Browse button to specify C:\GeoMedia 3D 2015_1 Tutorials\Viewsheds\3D 
SYMBOLS\Push Pin\Push_Pin.xpl2. 

10. Enter a value of 5 into the Scale drop-down control. 

Task 3: Modify Gradient Fill Style 

1. Click the Gradient Fill Style entry under the Fill Styles in the tree view to select this 
entry. 
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Notice the Start (Visible) and End (Hidden) options in the Color 
frame. These options have dual-purpose functions.  
 
In a 2D map window, they define the start and end colors of the 
gradient fill. 
 
In the 3D map window, they define the visible area and hidden area 
colors of the viewshed feature. 

2. Use the Color > End (Hidden) color button to specify black. 

3. Enter 30 into the Translucency > End (Hidden) text box.  

Task 4: Modify Simple Line Style 

1. Click the Simple Line Style entry under the Linear Styles in the tree view to select 
this entry. 

 

2. Use the Color button to specify a dark red color. 

3. Enter 0 into the Translucency text box.  

4. Enter 1 into the Width drop-down control.  

5. Click the 3D Settings tab to bring this tab to the forefront. 

 

Notice that Use relative altitude based on is set to Ellipsoid and 
that Use geometry Z values for altitude is checked. 
 
These settings are important and should remain as is because these 
options affect where the lines used to define the plane of viewshed 
appear when in 3D. 
 
If you were, for example, to change the Altitude options to Drape 
on surface, your viewshed, when selected in the 3D map window, 
will appear draped on the surface. 

Task 5: Save the Style for Future Use 

This style has a large number of settings and remembering all of the nuances can be tricky. 
Given this, let us save this style so that we can easily recreate it and make use of it in a future 
exercise. 
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1. Click OK to dismiss the Style Properties dialog box. 

2. Click the Name Style… button to display the Name Style dialog box. 

3. Enter the name Viewshed into the Style name text box. 

4. Click OK to save the style settings and to dismiss the dialog box. 

5. Click OK to dismiss the Legend Entry Properties dialog box. 

6. Notice the changes to the viewshed feature in the 2D map window 

 

7. Most notably, the star, the green through black gradient, and the boundary line all 
have a new appearance. 

8. Please note that some of the changes we made such as the addition of the 3D 
pushpin will not show up until we are in the 3D map window. 
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 Modifying an Existing Viewshed Exercise 3:
Using the Properties Dialog 

Objective: 
As noted earlier in this tutorial, viewshed features also have attributes and these attributes can be 
used to modify the appearance of the viewshed. Modifying these parameters can be done in a 2D 
map window or in the 3D map window. For now, let us make some modifications in the 2D map 
window. 

Task 1: Update Properties for Viewshed Feature (2D Map Window) 

1. Use the GeoMedia Select Tool to display the Properties dialog box for the viewshed 
feature we created earlier (that is, on the Home tab, in the Selection group, click 
Select Tool to enable the selection tool, and then double-click on the viewshed 
feature in the map window). 

 

 

 

As noted earlier, the attributes found here can be used to modify the 
appearance of each viewshed record. 
 
Please also note that your values will differ from those presented 
above.  

2. Enter 100 into the Direction Value field. 

3. Enter 250 into the Distance Value field. 

4. Click OK to close the Properties dialog box. 

 

Notice that the viewshed feature in the 2D map window automatically 
updates to reflect these changes. Namely, the direction shifted 
slightly and the outer edge of the viewshed boundary is now further 
away from the eye point location.  
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Task 2: Toggle to 3D 

1. On the 3D tab, in the View group, click Toggle 3D. 

 

Notice the changes. Most notably, the viewing eye point is 
represented by a small push pin, the hidden areas are now tinted 
black instead of red, the viewshed boundary lines are red, and the 
view distance is larger (that is more of the buildings now fall within 
the influence of the analysis). 

 

 

2. Use the navigation tool to alter the view so that it is similar to the one presented 
below. 
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Task 3: Update Properties for Viewshed Feature (3D Map Window) 

1. Use the GeoMedia Select Tool to display the Properties dialog box for the viewshed 
feature (that is, on the Home tab, in the Selection group, click Select Tool to enable 
the selection tool, and then double-click on the viewshed feature in the map window). 

 

 

 

Please note that your values will differ from those presented above.  

2. Enter -30 into the Pitch Value field. 

3. Enter 120 into the Horizontal_FOV Value field. 

4. Enter 90 into the Vertical_FOV Value field. 

5. Click OK to close the Properties dialog box. 

 

Notice that the viewshed feature in the 3D map window automatically 
updates to reflect these changes.  

The changes will be slight but you should notice slight differences. 

6. For fun, display the Properties dialog box again, and change the IsSpherical value 
to True. 

 

As noted above IsSpherical attribute contains a boolean value of 
either True or False. This attribute when set to True toggles the 
viewshed to a sphere.  

This option is often used to create threat domes. 
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7. On the 3D tab, in the View group, click Toggle 3D to toggle back to a 2D map 
window. 

 

Notice that the 2D window too is updated and that the viewshed 
features is now represented as a circle with a star in the middle of it. 
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 Modifying the Position of the Exercise 4:
Viewshed Eye Point Location 

Objective: 
The eye point location is stored using the X, Y, and Z values within the geometry. Given this, they 
cannot be modified using attribution, and therefore must be altered using the GeoMedia Desktop 
editing tools. 

Editing these features is easier in 2D than 3D; however, editing can be done in both views. For 
this part of the tutorial, we will edit the eye point location in 2D. 

Task 1: Understand the Geometry 

As noted earlier, viewshed features are represented using a compound geometry type. Let us 
review the geometry information of the viewshed feature we created before editing it. 

1. On the Home tab, in the Selection group, click Select Tool to enable the selection 
tool, and then click on the viewshed feature in the map window. 

2. Once the feature is selected, right-click to display the context menu. 

3. Choose Geometry Information from the list.  

4. Click on the + symbol beside Point to expand the tree view. 

 

5. Notice that the X, Y, and Z entries all have values. These values were populated 
during the Insert Viewshed command process.  
 
In this particular case, the values are expressed in meters. The X and Y values 
reflect the GeoWorkspace coordinate system and the Z value, 105.11, is meters 
above the ellipsoid. 

6. Click the Close button to dismiss the Geometry Information dialog box. 

Task 2: Modify the Z value 

1. Make sure that the viewshed feature is selected. 

2. On the Vector tab, in the Geometry group, click Edit > Edit…. 
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3. The map window will update to reflect that the feature is ready for editing (i.e. a 
collection of square handles will be displayed). 

 

4. Click on the center most handle to select it and hence select the viewshed eye point 
location point for editing. 

5. The handle will change to a circle. 

6. Right-click to display the context menu. 

7. Choose Edit Height from the list of options. 

8. Enter the 106 into the New height field (this value places the viewshed eye point 
approximately 1 meter above the top of building). 

9. Click the OK button to dismiss the Edit Height dialog box. 

Task 3: Modify the X and Y values 

1. Right-click to display the context menu again. 

2. Choose X, Y from the list of options. 

3. Enter the 620356 into the Easting field. 

4. Enter the 2354219 into the Northing field. 

5. Click the X button to dismiss the X and Y dialog box. 

6. Press the Esc key on your keyboard “twice” to exit the Edit command. 

Task 4: Examine results in the 3D Window 

1. On the 3D tab, in the View group, click Toggle 3D to toggle back to the 3D map 
window. 
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2. Your viewshed should now look similar to the one shown here, as all of your 
parameters should now match those found in the tutorial. 
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 Creating Viewsheds with Locks Exercise 5:

Objective: 
In exercise 2 we learned how to use the Insert Viewshed dockable control to interactively insert 
a viewshed feature. In this exercise we will make use of some of the additional options to insert a 
viewshed feature using locked parameters. 

Task 1: Insert a Second Viewshed Feature 

1. Use the navigation tools to navigate to an area that is in the hilly area similar to the 
one in the example below. We want an area that has a significant change in elevation 
and that is outside of the existing viewshed area. 

  

2. If the Insert Viewshed dockable control is no longer open, on the 3D tab, in the 
Analysis group, click Viewshed to display it.  

3. Ensure the Viewshed drop-down list contains Viewshed. 

4. Enter a value of 1500 into the Distance field (note: this will automatically toggle the 
lock button to the right of this field and fix the distance to 1500 meters). 

 

If you hover you cursor over the fields in Insert Viewshed dockable 
control you will see tooltips. These tooltips can be used to determine 
which field is the Distance field. 

5. When this field is locked, the viewing distance remains the same regardless of where 
the second mouse button location is. All locks work in a similar fashion (i.e. they lock 
the parameter down and therefore they do not reflect the location of the second 
mouse click). 

6. Click the mouse to define the eye point location. 

7. Click the mouse again to complete Insert Viewshed process. 

8. When the Viewshed Properties dialog box is displayed notice that the Distance 
value is 1500. 

9. Click OK to accept these parameters. 
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Please note that you can lock or unlock any of the parameters at any time during the insert 
process. For example, you could use the first click to define the eye point location, then move the 
mouse over the Insert Viewshed dockable control and enter a value for  Pitch (thereby locking 
this field), then return to the Insert Viewshed process. 



 

 
 

    23 

 Creating Viewsheds with An Exercise 6:
Offset 

Objective: 
In some instances it is beneficial to place the viewshed eye point a certain distance offset from 
the surface. For example, if you wanted place the eye point 2 meters (~ 6 feet) off the surface to 
reflect the eye point of a person, this can be done using the Altitude offset parameter in the 
Insert Viewshed dockable control.  

Task 1: Insert a Second Viewshed Feature 

1. Use the navigation tools to navigate to an area that is relatively flat, similar to the one 
in the example below. 

 

2. If the Insert Viewshed dockable control is no longer open, on the 3D tab, in the 
Analysis group, click Viewshed to display it.  

3. Ensure the Viewshed drop-down list contains Viewshed. 

4. Enter a value of 500 into the Distance field. 

5. Ensure the Distance field still is still locked. 

6. Enter a value of 100 into the Altitude offset field. 

 

This value will place the eye point 100 meters above the surface 
when you click the mouse to define the eye point.   
 
Please note that in this case, the Distance parameter (set in the Units 
and Formats dialog) is set to meters, and therefore this value reflects 
this setting. 

7. Move the cursor over the map window. 
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Notice that in this case there is a small vertical line, projecting up 
from your cursor location. This line reflects the altitude offset of 100 
meters. This is done so that you can visually see the location of the 
offset eye point location. 

 

8. Click the mouse to define the eye point location. 

9. Click the mouse again to complete Insert Viewshed process. 

10. When the Viewshed Properties dialog box is displayed notice that the Distance 
value is 500. 

11. Click OK to accept these parameters. 

12. Press the Esc key on your keyboard to exit the Insert Viewshed command. 
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Using an Existing Feature Section 2:  
Class as a Viewshed Feature 

Section Objective 

This section is intended to introduce you to a workflow that can be used to turn an existing point-
based feature class into a viewshed feature class. There are a number of ways to do this using a 
variety of commands, however for the purposes of this section two queries will be used. 
 

Tools Used 

This section makes use of the Functional Attributes and Attribute Selection commands. 
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 Creating the Required Viewshed Exercise 1:
Attributes  

Objective: 
As noted earlier in this tutorial, a viewshed feature class contains a collection attributes and these 
attributes must be in place as they are used to drive the analysis.  The objective of this exercise is 
to use the Functional Attribute command to add the Vertical_FOV, Horizontal_FOV, 
IsSpherical, and Pitch attributes to a query. 

Task 1: Display the Functional Attributes Command 

The Functional Attribute command allows you to edit or delete functional attributes for a 
selected feature class or query. 

1. On the Analysis tab, in the Analytical group, click Functional Attributes to display 
the Functional Attributes dialog box.  

2. Use the Add functional attributes for drop-down list to select Viewer_Locations. 

3. Click the New button to display the Functional Attribute dialog box. 

Task 2: Add the Vertical_FOV Field 

The Functional Attribute dialog box (sometimes called the Expression dialog box), allows you to 
create and edit the name and expression for a functional attribute. This dialog box functions as a 
calculator that you can use to provide calculated information for queries. This calculator provides 
a simple Excel-like interface with standard operators plus syntax information. 

1. Use the Functional attribute name text box to specify Vertical_FOV as the output 
attribute name.  

2. Enter 60.0 into the Expression text box. 

 

If you recall, the Vertical_FOV controls the vertical field of view for 
the viewshed. This field contains a value expressed in degrees (1 to 
180). In this case, we are setting this value to 60 for all eye point 
locations. If need be, this value can be changed later, after the 
results are written to a feature class. 

3. Click the Add button to create this functional attribute. 

Task 3: Add the Horizontal_FOV Field 

As noted earlier, the Horizontal_FOV attribute controls the horizontal field of view for the 
viewshed. This field contains a value expressed in degrees (1 to 120). 

1. Use the Functional attribute name text box to specify Horizontal_FOV as the output 
attribute name.  
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2. Enter 90.0 into the Expression text box. 

 

In this case, we are setting this value to 90 for all eye point locations. 
If need be, this value can be changed later, after the results are 
written to a feature class. 

3. Click the Add button to create this functional attribute. 

Task 4: Add the IsSpherical Field 

As noted earlier, the IsSpherical attribute contains a boolean value of True or False. Where True 
toggles the viewshed to a sphere. 

1. Use the Functional attribute name text box to specify IsSpherical as the output 
attribute name.  

2. Enter FALSE() into the Expression text box. 

 

In this case, we are setting this value to False for all eye point 
locations. If need be, this value can be changed later, after the 
results are written to a feature class. 

3. Click the Add button to create this functional attribute. 

Task 5: Add the Pitch Field 

As noted earlier, the Pitch attribute contains a value expressed in degrees (-90 to 90). This value 
controls the pitch angle for the viewshed.  

1. Use the Functional attribute name text box to specify Pitch as the output attribute 
name.  

2. Enter -10.0 into the Expression text box. 

 

In this case, we are setting this value to -10 for all eye point 
locations. If need be, this value can be changed later, after the 
results are written to a feature class. 

3. Click the Add button to create this functional attribute. 

4. Click the Close button on the Functional Attribute dialog box. 

5. Use the Query name text box to specify Viewer_Locations_Template. 

6. Uncheck the Display functional attributes in map window check box. 

7. Uncheck the Display functional attributes in data window check box. 

8. Click the OK button to close the Functional Attributes dialog box and create the 
Viewer_Locations_Template query. 
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 Renaming Attributes to Reflect Exercise 2:
Viewshed Attribute Names 

Objective: 
In the previous exercise, we created 4 (Vertical_FOV, Horizontal_FOV, IsSpherical, and Pitch) 
of the 7 required attributes for a viewshed feature class. However, the existing feature class 
(Viewer_Locations) that we want to use as input into the Insert Viewshed command already 
contains three attributes that can be used to automatically populate the 3 remaining attributes 
(Name, Direction, and Distance). 

The objective of this exercise is to learn how to make use of existing attributes within the Insert 
Viewshed command. Namely, we will use the Select Attributes command to create a query that 
builds upon the Viewer_Locations_Template query created above. 

More specifically, we will map the Viewer_Name, Viewer_Direction, and Viewer_Distance 
attributes to the viewshed features class attributes Name, Direction, and Distance respectively. 

Task 1: Open the Attribute Selection Command 

The Attribute Selection command allows you to specify a subset of input attribute fields, change 
the names of the fields, and reorder the fields in a feature class or query for output. 

1. On the Analysis tab, in the Attribute group, click the Selection button to display the 
Attribute Selection dialog box. 

Task 2: Rename the Viewer_Name attribute to Name 

A viewshed feature class requires a name for each viewshed in the feature class. In this case, the 
existing attribute Viewer_Name can be used for this and hence reused.  

1. Use the Select attributes from drop-down list to select Viewer_Locations_Template. 

2. Click on the entry Viewer_Name entry in the Attributes list to select it. 

3. Click the Rename button to display the Rename Attribute dialog box. 

4. Enter Name into the New name text box. 

5. Click the OK button to close the Rename Attribute dialog box. 

Task 3: Rename the Viewer_Direction attribute to Direction 

A viewshed feature class must contain an attribute called Direction. This value controls the view 
direction for the viewshed and is expressed in degrees (0 to 360). In this case, the existing 
attribute Viewer_Direction is already a double and hence can be reused. 

1. Click on the entry Viewer_Direction entry in the Attributes list to select it. 

2. Click the Rename button to display the Rename Attribute dialog box. 

3. Enter Direction into the New name text box. 

4. Click the OK button to close the Rename Attribute dialog box. 
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Task 4: Rename the Viewer_Distance attribute to Distance 

A viewshed feature class must contain an attribute called Distance. This value controls the view 
distance for the viewshed. In this case, the existing attribute Viewer_Distance is already a 
double and hence can be reused. 

1. Click on the entry Viewer_Distance entry in the Attributes list to select it. 

2. Click the Rename button to display the Rename Attribute dialog box. 

3. Enter Distance into the New name text box. 

4. Click the OK button to close the Rename Attribute dialog box. 

5. Use the Query name text box to specify Viewer_Locations_Converted. 

6. Uncheck the Display in map window check box. 

7. Check the Display in data window check box. 

8. Enter Viewer_Locations_Converted into the Data window name drop-down list. 

9. Click the OK button to close the Attribute Selection dialog box and display the data 
window called Viewer_Locations_Converted. 

Task 5: Review the Results 

With the two database processes complete we have two queries and together these queries have 
created a query that perfectly mimics a viewshed feature class. 

1. Notice the data window. This data window displays the attributes and values that 
make up the previously created query. 

 

2. Notice that the Vertical_FOV, Horizontal_FOV, IsSpherical, and Pitch columns are 
shaded. These are shaded because they contain computed values (done as part of 
the Functional Attribute) and hence cannot be changed. If you would like to be able 
to overwrite or modify these values, the query must be output to a feature class. 

3. Click the X button to close the data window. 
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 Displaying a Viewshed Using an Exercise 3:
Existing Feature Class  

Objective: 
Unlike the previous exercises in which viewshed features were created interactively, we can now 
make use of an existing feature class to display viewshed representations in the 3D map window. 

Task 1: Use the Query to Display Viewshed Representations in 3D 

1. On the Home tab, in the Legend group, click Legends > Add Legend Entries to 
display the Add Legend Entries dialog box.  

2. Use the tree view control to place a check mark beside the 
Viewer_Locations_Converted entry (under Queries). 

3. Click the OK button to dismiss the Add Legend Entries dialog box and to display the 
query results in the 3D map window. 

4. Right-click on the Viewer_Locations_Converted legend entry, then select Fit by 
Legend Entry from the context menu. Notice that the 2D representations of the three 
viewshed features are shown draped on the ground in the 3D map window. 

Task 2: Stylize the Viewer_Locations_Converted Legend Entry 

As discussed earlier in this tutorial, Viewshed features must conform to a collection of stylization 
parameters to be viewed correctly while in the 3D window. In a previous exercise, we saved a 
style to help us.  

1. Double click the  icon of the legend entry Viewer_Locations_Converted to 
display the Legend Entry Properties dialog box. 

2. Click on the Viewshed style in the Name styles control. 

3. Click the OK button to close the Legend Entry Properties dialog box and to update 
the style. 

4. Notice that the contents of the 3D map window update to reflect these changes. 

 

In this section the existing feature class name Viewer_Locations was already a Compound 
feature (required for use as input into the Insert Viewshed command).  

If in the future, you want to make use of a similar workflow to create viewshed feature class from 
an existing feature class that is not a Compound feature (i.e. is a Point feature only); you can 
make use of the Database Utilities executable found in the Start menu to convert a Point-based 
feature to a Compound-based feature.  

Task 3: Exit GeoMedia Desktop 

You have completed this exercise. You can now exit GeoMedia Desktop and run through the next 
exercise. Given that you may want to revisit this exercise, it is recommended you do not save any 
of your changes and can therefore restart the exercise with a clean GeoWorkspace. 
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1. Click the X icon in the upper-right corner of the GeoMedia Desktop application 
window to exit GeoMedia Desktop.   

2. When asked if you wish to save changes, click No. 

 

 


